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In this chapter, you will learn:
•	 About attributes and define them with a block.
•	 To create annotative block attributes.
•	 To edit attribute tag names.
•	 To insert blocks with attributes and assign values to attributes.
•	 To extract attribute values from inserted blocks.
•	 To control attribute visibility.
•	 To perform global and individual editing of attributes.
•	 To insert a text file in a drawing to create Bill Of Materials.
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Understanding Attributes
AutoCAD LT has provided a facility that allows the user to attach information to blocks. This 
information can then be retrieved and processed by other programs for various purposes. For 
example, you can use this information to create a bill of material for a project, find the total 
number of computers in a building, or determine the location of each block in a drawing. 
Attributes can also be used to create blocks (such as title blocks) with prompted or preformatted 
text, to control text placement. The information associated with a block is known as attribute 
value or attribute. AutoCAD LT references the attributes with a block through tag names.

Before assigning attributes to a block, you must create an attribute definition by using the Define 
Attributes tool. The attribute definition describes the characteristics of the attribute. You can 
define several attribute definitions (tags) and include them in the block definition. Each time you 
insert the block, AutoCAD LT will prompt you to enter the value of the attribute. The attribute 
value automatically replaces the attribute tag name. The information (attribute values) assigned 
to a block can be extracted and written to a file by using AutoCAD LT’s EATTEXT command. 
This file can then be inserted in the drawing as a table or processed by other programs to analyze 
the data. The attribute values can be edited by using the EATTEDIT command. The display of 
attributes can be controlled by using the ATTDISP command.

Defining Attributes
  Ribbon:   Insert > Block Definition > Define Attributes		  Command:   ATTDEF  

When you invoke the Define Attributes tool, the Attribute Definition dialog box is displayed, 
see Figure 15-1. The block attributes can be defined through this dialog box. When creating an 
attribute definition, you must define the mode, attributes, insertion point, and text information 
for each attribute. All these information can be entered in the dialog box. The following is the 
description of each area of the Attribute Definition dialog box:

Figure 15-1  The Attribute Definition dialog box

Mode Area
The Mode area of the Attribute Definition dialog box has six check boxes: Invisible, Constant, 
Verify, Preset, Lock position, and Multiple lines. These check boxes determine the display 
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and edit features of the block attributes. For example, if you select the Invisible check box, 
the attribute becomes invisible which means, it is not displayed on the screen. Similarly, if the 
Constant check box is selected, the attribute becomes constant. This means that its value is 
predefined and cannot be changed. These options are described next.

Invisible
This option lets you create an attribute that is not visible on the screen, by default. Select this 
check box if you want the attribute to be invisible.

Tip
The Invisible mode is especially useful when you do not want the attribute values to be displayed 
on the screen to avoid cluttering the drawing. Also, if the attributes are invisible, it takes less 
time to regenerate the drawing. 

You can make the invisible attribute visible by using the ATTDISP command discussed later in 
this chapter, in the section “Controlling Attribute Visibility”.

Constant
This option lets you create an attribute that has a fixed value and cannot be changed after block 
insertion. When you select this mode, the Prompt edit box and the Verify and Preset check 
boxes are disabled. Since the value is constant, there is no need to be prompted for new values. 
This check box is cleared by default and you can use different attribute values for the blocks.

Verify
This option allows you to verify the attribute value you have entered when inserting a block by 
asking you twice for the data. If the value is incorrect, you can correct it by entering the new value. 
If this check box is cleared, you are not prompted for verification of the attribute values.

Preset
This option allows you to create an attribute that is automatically set to the default value. The 
attribute values are not requested when you insert a block and the default values are used. But 
unlike a constant attribute, the preset attribute value can be edited later.

Lock position
This check box is selected by default and it is used to lock the position of the attributes with 
respect to the block object. In case of non-dynamic blocks, if the attributes are created with the 
Lock position check box cleared, then a separate grip will be displayed on that attribute. This 
grip can be used to modify the location of the attribute. When the dynamic blocks are created with 
the Lock position check box cleared, the separate grip does not get displayed on the attribute. 
Besides this, the attribute cannot be manipulated by the parameters and action. 

Multiple lines
Select this check box to specify that the default value of the attribute may be a single-line or 
multiple line text.

Attribute Area
The Attribute area (Figure 15-2) of the Attribute 
Definition dialog box has three edit boxes: Tag, Prompt, 
and Default, where you can enter values. You can 
enter up to 256 characters in these edit boxes. If the 
first character to be entered in any one of these edit boxes 
is a space, you should start with a backslash (\). But if the 

Figure 15-2  The Attribute area of the 
Attribute Definition dialog box
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first character is a backslash (\), you should start the value to be entered with two backslashes 
(\\). The three edit boxes have been described next.

Tag
This is like a label that is used to identify an attribute. For example, the tag name COMPUTER 
can be used to identify an item. Here you can enter the tag names as uppercase, lowercase, or 
both, but all lowercase letters are automatically converted into uppercase when displayed. The 
tag name cannot be null. Also, it must not contain any blank spaces. 

Tip
It is advisable to specify a tag name that reflects the contents of the item being tagged. For example, 
the tag name COMP or COMPUTER is an appropriate name for labeling computers.

Prompt
The text that you enter in the Prompt edit box is used as a prompt when you insert a block that 
contains the defined attribute. For example, if COMPUTER is the tag, you can enter What is 
the MEMORY? or ENTER MEMORY: in the Prompt edit box. AutoCAD LT will then prompt 
you with this same statement when you insert the block with which the attribute is defined. If 
you have selected the Constant check box in the Mode area, the Prompt edit box is not avail-
able because no prompt is required if the attribute is constant. If you do not enter anything in 
the Prompt edit box, the entry made in the Tag edit box is used as the prompt.

Default
The entry in the Default edit box defines the default value of the specified attribute. If you do 
not enter a value, the attribute takes the value entered in the Tag edit box. The entry of a value 
is optional.

Insert Field
This button is used to insert a field as the value of the attribute. When you choose this 
button, the Field dialog box is displayed that can be used to insert the required field.

Multiline Editor
This button is displayed in place of the Insert Field button when the Multiple lines 
check box is selected from the Mode area. Choose this button to invoke the Text 
Formatting window on the screen. You can enter the text that you want to assign as the 
default value of the attribute in the text window.

Note
The Text Formatting toolbar displayed here has only some commonly used options. The full 
Text Formatting toolbar can be displayed by changing the value of the ATTIPE system variable 
to 1. 

Insertion Point Area
The Insertion Point area of the Attribute Definition dialog box 
(Figure 15-3) lets you define the insertion point of the block attribute 
text. You can define the insertion point by entering the values in the X, Y, 
and Z edit boxes or by specifying it on the screen. To specify the insertion 
point on the screen, select the Specify on-Screen check box. Now, set the 
parameters in all the other fields and areas and then choose OK. You will 
be prompted to select the start point of the attribute. Figure 15-3  The 

Insertion Point area
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Just below the Insertion Point area of the dialog box is a check box labeled Align below previous 
attribute definition. This check box is not available when you use the Attribute Definition 
dialog box for the first time. After you have defined an attribute and when you press ENTER 
to display the Attribute Definition dialog box again, this check box is available. You can select 
this check box to place the subsequent attribute text just below the previously defined attribute 
automatically. When you select this check box, the Insertion Point area and the Text Settings 
areas of the dialog box are not available and AutoCAD LT assumes previously defined values for 
text such as text height, text style, text justification, and text rotation. The text is automatically 
placed on the following line. 

Text Settings Area
The Text Settings area of the Attribute Definition dialog 
box (Figure 15-4) lets you control the justification, text 
style, annotation property, height, rotation, and boundary 
width of the attribute text. To set the text justification, 
select a justification type from the Justification drop-down 
list. The default option is Left for the single line text and 
Top left for the multiline text. Similarly, you can use the 
Text style drop-down list to select a text style. All the 
text styles defined in the current drawing are displayed 
in the Text style drop-down list. The default text style 
is Standard. To write annotative attributes, select the 
Annotative text style from the Text style drop-down list. 
Select the Annotative check box to assign the annotative 
property to the attribute text. The annotative attributes can be attached to both the annotative 
or non-annotative blocks. Choose the information (i) button on the side of the Annotative check 
box to collect more information about the annotative object. You can specify the text height 
and text rotation in the Text height and Rotation edit boxes, respectively. You can also define 
the text height by choosing the Text height button. When you choose this button, AutoCAD LT 
temporarily exits the Attribute Definition dialog box and lets you enter the height value by 
selecting points on the screen or from the Command prompt. Once the height on the screen is 
defined, the Attribute Definition dialog box will reappear and the defined text height will be 
displayed in the edit box. Similarly, you can define the text rotation by choosing the Rotation 
button and then selecting points on the screen or by entering the rotation angle at the Command 
prompt. The Boundary width edit box is used to specify the maximum width for the multiline 
text. If the width of the text line is more than this value, the text will automatically go to the 
second line. This edit box will be available only when you select the Multiple lines check box 
from the Mode area.

Note
The text style must be defined before it can be used to specify the text.
			 
If you select a style that has the predefined height, AutoCAD LT automatically disables the Text 
height edit box.

If you have selected the Align option from the Justification drop-down list, the Insertion Point 
area and the Text height and Rotation edit boxes in the Text Settings area will be disabled.

If you have selected the Fit option from the Justification drop-down list, the Insertion Point 
area and the Rotation edit box are disabled. To specify the location of the attribute, choose OK 
from the dialog box. AutoCAD LT prompts you to specify the first and second endpoints of the 
text baseline. The text will fit between the two endpoints that you specify.

Figure 15-4  The Text Settings area of 
the Attribute Definition dialog box
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After you complete the settings in the Attribute Definition 
dialog box and choose OK, the attribute tag text is inserted in 
the drawing at the specified insertion point. Now, you can use 
the BLOCK or WBLOCK commands to select all the objects 
and attributes to define a block. 

Note
You can use the -ATTDEF command to display the dynamic 
prompt in the drawing area. The options in the Attribute 
Definition dialog box are available through the dynamic 
prompt too. See Figure 15-5.

Example 1 					       Attribute Definition
In this example, you will define the following attributes for a computer and then create a block 
using the BLOCK command. The name of the block is COMP.

Figure 15-5  Dynamic prompt 
for the -ATTDEF command

Mode 	      Tag name	 Prompt	          		  Default value

Constant	      ITEM						      Computer

Preset, Verify	      MAKE		  Enter make:			   CAD-CIM

Verify		       PROCESSOR	 Enter processor type:		  Unknown

Verify		       HD			   Enter Hard-Drive size:		  40 GB

Invisible, Verify	      RAM		  Enter RAM:			   256 MB

1.	 Draw the sketch of a computer, as shown in Figure 15-6. Assume the dimensions, or measure 
the dimensions of the computer you are using for AutoCAD LT.

Figure 15-6  Drawing for Example 1

2.	 Choose the Define Attributes tool from the Block Definition panel in the Insert tab; the 
Attribute Definition dialog box is displayed.

3.	 Define the first attribute shown in the preceding table. Select the Constant check box in 
the Mode area because the mode of the first attribute is constant. In the Tag edit box, enter 
the tag name, ITEM. Similarly, enter Computer in the Default edit box. Note that the 
Prompt edit box is not available because the mode is constant.
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4.	 In the Insertion Point area, select the Specify on-screen check box to define the text 
insertion point. 

5.	 In the Text Settings area, specify the justification, style, annotative property, height, and 
rotation of the text.

6.	 Choose the OK button once you have entered information in the Attribute Definition dialog 
box. Select a point below the insertion base point (P1) of the computer to place the text.

7.	 Press Enter to invoke the Attribute Definition dialog box again. Enter the mode and 
attribute information for the second attribute as shown in the table at the beginning of 
Example 1. You need not define the insertion point and text options again. Select the 
Align below previous attribute definition check box that is located just below the Insertion 
Point area. You will notice that when you select this check box, the Insertion Point and 
Text Settings areas are not available. Now, choose the OK button. AutoCAD LT places the 
attribute text just below the previous attribute text.

 
8.	 Similarly, define the remaining attributes also (Figure 15-7).

Figure 15-7  Attributes defined below the 
computer drawing

9.	 Now, use the BLOCK command to create a block. Make sure that the Retain radio button is 
selected in the Objects area. The name of the block is COMP, and the insertion point of 
the block is P1, midpoint of the base. When you select objects for the block, make sure you 
also select attributes. 

10.	 Insert the block created. You will notice that the order of prompts is the same as the order 
of attributes selection.

Editing Attribute Definition
   Menu Bar:   Modify > Object > Text > Edit     	 Command:  DDEDIT  

You can edit the text and attribute definitions before you define a block, using the 
DDEDIT command. After invoking this command, AutoCAD LT will prompt you to 
Select an annotation object or [Undo]. If you select an attribute created using the 

Attribute Definition dialog box, the Edit Attribute Definition dialog box is displayed 
(Figure 15-8). 

You can also invoke the Edit Attribute Definition dialog box by double-clicking on the attribute 
definition. You can enter the new values in the respective edit boxes. Once you have entered 
the changed values, choose the OK button in the dialog box. After you exit the dialog box, 
AutoCAD LT will continue to prompt you to select another text or attribute object (Attribute 
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tag). If you have finished editing and do not want to select another attribute object to edit, press 
ENTER to exit the command.

Figure 15-8  The Edit Attribute Definition dialog box

Using the Properties Palette
The Properties tool has been already discussed in Chapter 4, 
Working with Drawing Aids. It can also be used to edit defined 
attributes. Select the attribute to be modified and right-click 
to display a shortcut menu. Next, choose Properties from 
the shortcut menu; the Properties palette will be displayed, 
see Figure 15-9. You will notice that Attribute Definition is 
displayed in the text box located at the top of the palette. 
Also, you will find that all properties of the selected attribute 
are displayed under four headings. They are General, Text, 
and Misc. You can change these values in their corresponding 
fields. For example, you can modify the color, layer, linetype, 
thickness, linetype scale, and so on, of the selected attribute 
under the General head. Similarly, you can modify the tag 
name, prompt, and value of the selected attribute in the Tag, 
Prompt, and Value fields under the Text heading. Under the 
Text head, you can also modify the text style, justification, 
annotation scale, text height, rotation angle, width factor, and 
make the angle values of the selected attribute oblique.

You can also determine if you want the attribute text to appear 
upside down or backwards or not under the Misc heading. 
Here, you can also modify the attribute modes, which have 
been already defined. When you select a particular mode, for 
example Invisible, a drop-down list is available in the corresponding field. This list displays 
two options, Yes and No. If you select Yes, the attribute is made invisible and if you select No, 
the attribute is made visible. To select a particular mode, you should choose Yes from their 
corresponding drop-down lists. 

Note
Remember that if you change the justification of the first attribute below which you have aligned 
the remaining attributes, the remaining attributes will not be updated automatically. You will 
have to change justifications of the remaining attributes individually to align them below the 
first attribute.

If you change the justification of the attributes from align to some other, the size of the text will 
also be changed. 

You can also use the CHANGE command to edit the attribute objects using the Command 
prompt.

Figure 15-9  The Properties 
palette to modify attributes
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Inserting Blocks with Attributes
The value of the attributes can be specified during block insertion, either at the Command 
prompt or in the Edit Attributes dialog box, if the system variable ATTDIA is set to 1. When 
you use the Insert tool or the -INSERT command to insert a block in a drawing, and after you 
have specified the insertion point, scale factors, and rotation angle, the Edit Attributes dialog 
box (Figure 15-10) will be displayed. 

Figure 15-10  The Edit Attributes dialog box

The default value for ATTDIA is 0, which disables the dialog box. The prompts and their 
default values, which you had specified with the attribute definition, are then displayed on the 
Command prompt after you have specified the insertion point, scale, and rotation angle for 
the block to be inserted.

In the Edit Attributes dialog box, the prompts that were entered at the time of attribute definition 
in the dialog box are displayed with their default values in the corresponding fields. If an attribute 
has been defined with the Constant mode, it is not displayed in the dialog box because a constant 
attribute value cannot be edited. You can enter the attribute values in the fields located next 
to the attribute prompt. If no new values are specified, the default values are displayed. Eight 
attribute values are displayed at a time in the dialog box. If there are more attributes, they can 
be accessed by using the Next or Previous buttons. The block name is displayed at the top of 
the dialog box. After entering the new attribute values, choose the OK button. AutoCAD LT 
will place these attribute values at the specified location.

Tip
It is more convenient to use the Edit Attributes dialog box because you can view all the attribute 
values at a glance and can correct them before placing. Therefore, it is a good idea to set the 
ATTDIA value to 1, before you insert a block with attributes. 

Attributes can also be defined from the Command prompt by setting the system variable ATTDIA 
to 0 (default value). Now, when you use the Insert tool, AutoCAD LT does not display the 
Edit Attributes dialog box. Instead, AutoCAD LT prompts you to enter the attribute values 
for various attributes that have been defined in the block at the pointer input.
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	 Computer	       CAD-CIM		        Unknown	       600 MB	      Standard

1.	 Draw the floor plan shown in Figure 15-11 (assume the dimensions).

Figure 15-11  Floor plan drawing for Example 2

2.	 Set the system variable ATTDIA to 1. Use the Insert tool available in the Blocks panel in 
the Insert tab to insert the blocks. When you invoke the Insert tool, the Insert dialog box 
is displayed. Enter COMP in the Name edit box and choose OK to exit the dialog box. 
Select an insertion point on screen to insert the block. After you specify the insertion point, 
the Edit Attributes dialog box is displayed. In this dialog box, you can specify the attribute 
values, if you need to, in the different edit boxes. 

3.	 Choose the Insert tool again to insert other blocks and define their attribute values, as 
shown in Figure 15-12.

4.	 Save the drawing for further use.

ITEM	 MAKE	 PROCESSOR	 HD		  RAM

Computer	 Gateway		  486-60		  150 MB		 16 MB

Computer	 Zenith			   486-30		  100 MB		 32 MB

Computer	 IBM			   386-30		  80 MB		  8 MB

Computer	 Del			   586-60		  450 MB		 64 MB

Computer	 CAD-CIM		  Pentium-90        100 Min	 32 MB

Example 2 								        Attdia
In this example, you will insert the block (COMP) that was defined in Example 1. The following 
is the list of the attribute values for computers:
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Figure 15-12  The floor plan after inserting blocks and defining their attributes

Managing Attributes
  Ribbon:   Insert > Block Definition > Manage Attributes	            Command:  BATTMAN	  
  Menu Bar:  Modify > Object > Attribute > Block Attribute Manager			 

The Manage Attributes tool allows you to manage attribute definitions for blocks in the 
current drawing through the Block Attribute Manager dialog box. This dialog box is 
shown in Figure 15-13. By default, any attribute changes you make are applied to all 

existing block references in the current drawing. Immediate changes in the default value of the 
attribute in the existing drawing can only be seen upon regeneration, if the attribute that is 
edited is in the Constant mode. If the mode is other than Constant, the changes in the attribute 
can only be seen for new block insertions.

Figure 15-13  The Block Attribute Manager dialog box  

When you invoke this tool, AutoCAD LT displays the number of blocks that exist in the current 
drawing below the list box in the dialog box. The block can be in the model space or in the 
layout. The names of the existing blocks in the current drawing are displayed in the Block 
drop-down list. Attributes of the selected block are displayed in the attribute list. By default, the 
Tag, Prompt, Default, Modes, and Annotative attribute properties are displayed in the attribute 
list. You can edit the attribute definitions in blocks, remove attributes from blocks, and change 
the order in which you were prompted for attribute values while inserting the block.



15-12 AutoCAD LT 2013 for  Des igners

Select block
This button allows you to select a block from the drawing area whose attributes you want to 
edit. When you choose the Select block button, the dialog box closes temporarily until you 
select block from the drawing or cancel by pressing ESC. Once you have selected the block, the 
dialog box is displayed again. The name of the block you have selected is displayed in the Block 
drop-down list. If you modify the attributes of a block and then select a new block before saving 
the attribute changes, you will be prompted to save the changes before selecting another block 
through an alert message box (Figure 15-14). 

Figure 15-14  The Block Attribute Manager Alert message box

Block Drop-down List
This drop-down list in the Block Attribute Manager dialog box allows you to choose the block 
whose attributes you want to modify. It lists all the blocks in the current drawing that have 
attributes.

Sync
This button of the Block Attribute Manager dialog box allows you to update all instances of 
the selected block with the attribute properties currently defined. This does not affect any of 
the values assigned to attributes in each block when attributes were defined. On choosing this 
button, you can update attributes in all block references in the current drawing with the changes 
you made to the block definition. For example, you may have used the Block Attribute Manager 
dialog box to modify attribute properties of several block definitions in your drawing. But you 
do not want it to automatically update the existing block references when you made the changes. 
Now, when you are satisfied with the attribute changes you made, you can apply those changes 
to all blocks in the current drawing by using the Sync button. 

You can also use the Synchronize tool in the Attributes panel to update attribute 
properties in block references to match their block definition. This command can also 
be invoked by entering ATTSYNC at the Command prompt or by choosing the 
Synchronize Attributes tool from the Modify II toolbar.

Note
Changing the attribute properties of an existing block does not affect the values assigned to the 
block. For example, in a block containing an attribute whose Tag is Cost and default value is 
200. The default value 200 remains unaffected, if the Tag is changed to UnitCost.

Move Up
This button moves the selected attribute tag earlier in the prompt sequence. Now, when you 
insert the block, the attribute you have just moved up will appear earlier in the prompt sequence. 
The Move Up button is not available when a constant attribute is selected and if the attribute 
is at the topmost position in the attribute list. 

Move Down
This button moves the selected attribute tag later in the prompt sequence. The Move Down 
button is not available when a constant attribute is selected and when the attribute is at the 
bottom position in the attribute list.
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Tip
When you define a block, the order in which you select the attributes determines the order in 
which you are prompted for the attribute information when you insert the block. You can use the 
Block Attribute Manager to change the order of prompts that request attribute values.

Edit
This button of the Block Attribute Manager allows you to modify the attribute properties. To 
edit the attribute definition in blocks, select the attribute and then choose Edit from the dialog 
box; the Edit Attribute dialog box will be displayed. In the dialog box, Active Block displays 
the name of the block that you have selected and whose properties have to be edited.

Note
To edit an attribute, you can also double-click on the attribute or choose the Single tool from 
Insert > Block > Edit Attributes drop-down. Then, select the attribute to display the 
Enhanced Attribute Editor dialog box.

The options in the Edit Attribute dialog box are discussed next.

Attribute Tab
The options under the Attribute tab of the Edit Attribute dialog box are used to modify the 
mode and data of attributes (see Figure 15-15). The options under the Mode area can be selected 
for the block. The Data area of the dialog box has three edit boxes: Tag, Prompt, and Default, 
where you can enter the data to be changed. 

Figure 15-15  The Attribute tab of the Edit Attribute dialog box

Text Options Tab
The options under this tab (Figure 15-16) are used to set the properties that define the way an 
attribute’s text is displayed in the drawing. The options in this tab are discussed next.

Text Style. This drop-down list specifies the text style for attribute text. Default values for this 
text style are assigned to the text properties displayed in this dialog box. 

Justification. This drop-down list specifies how attribute text is justified. 

Height. This edit box specifies the height of the attribute text. If the height is defined in the 
current text style, this edit box is not available.

Rotation. This edit box specifies the rotation angle of the attribute text.
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Figure 15-16  The Text Options tab of the Edit Attribute dialog box

Backwards. This check box specifies whether or not the text is displayed backwards. Select this 
box to display the text backwards.

Upside down. This check box specifies whether or not the text is displayed upside down. Select 
this box to display the text upside down. 

Width Factor. This edit box sets the character spacing for attribute text. Entering a value less 
than 1.0 condenses the text and a value greater than 1.0 expands it. 

Oblique Angle. In this edit box, the angle at which the attribute text is slanted away from its 
vertical axis is specified.

Annotative. This check box is used to convert the non-annotative attribute to the 
annotative attribute and vice-versa.

Boundary Width. This edit box sets the width of the boundary that will be displayed while 
writing the multiline text for the attributes’ default value. The value specified here is the relative 
scale value. If you specify a value less than 1, it will decrease the boundary width. Whereas, if 
you specify a value more than 1, it will increase the boundary width. Accordingly, the paragraph 
width for the multiline text will increase or decrease. You can modify the value of the boundary 
width only when you select the Multiple lines check box from the Mode area of the Attribute 
Definition dialog box. 

Note
If you change the above-mentioned properties of the Constant attribute, you may need to 
regenerate the drawing to view the effects. 

Properties
The options under this tab of the Edit Attribute dialog box (Figure 15-17) are used to define 
the layer that the attribute is on and the color, lineweight, and linetype for the attribute’s line. 
Also, if the drawing uses plot styles, you can assign a plot style to the attribute. The options of 
the Properties tab are discussed next.

Layer. This drop-down list specifies the layer that the attribute is on. The layer on which the 
attribute was defined is displayed here in this drop-down list. This cannot be changed using 
the dialog box.

Linetype. This drop-down list specifies the linetype of attribute text.
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Color. This drop-down list specifies the attribute’s text color.

Figure 15-17  The Properties tab of the Edit Attribute dialog box

Lineweight. This drop-down list specifies the lineweight of attribute text. The changes you make 
to this option do not come into effect if the LWDISPLAY system variable is off.

Plot Style. This drop-down list specifies the plot style of the attribute. If the current drawing 
uses color-dependent plot styles, the Plot style list in this dialog box is not available.

Auto preview changes
This check box controls whether or not the drawing area is immediately updated to display any 
visible attribute changes you make. If the Auto preview changes check box is selected, changes 
are immediately visible. If this check box is cleared, changes are not immediately visible.

Tip
The buttons such as Move Up, Move Down, Edit, Remove, and Settings can also be invoked 
by using the shortcut menu, which appears by right-clicking on the attributes in the attribute 
list in the Block Attribute Manager dialog box.

Settings
Choosing this button of the Block Attribute Manager opens the Block Attribute Settings dialog 
box (Figure 15-18), where you can customize how attribute information is listed in the Block 
Attribute Manager.

Figure 15-18  The Block Attribute Settings dialog 
box
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Display in list
You can specify the attribute properties you want to be displayed in the list by selecting the 
check boxes available in this area of the Block Attribute Settings dialog box. This area shows 
the check boxes of all the properties that are displayed in the attribute list. Only the check boxes 
of the properties selected are displayed in the attribute list. These properties can be viewed in 
the attribute list by scrolling it. The Tag check box is always selected by default.

This area of the dialog box has two buttons, Select All and Clear All, which select and clear all 
the check boxes, respectively.

Emphasize duplicate tags
This check box turns duplicate tag emphasis on and off. If this check box is selected, duplicate 
attribute tags are displayed in red type in the attribute list. For example, if a block has PRICE 
as a tag more than once, the attribute PRICE will be displayed in red in the attribute list. If this 
check box is cleared, duplicate tags are not emphasized in the attribute list.

Apply changes to existing references
This check box of the dialog box is used to specify whether or not to update all existing instances 
of the block whose attributes you are modifying. Therefore, if this check box is selected, all 
instances of the block with the new attribute definitions are updated. If this check box is cleared, 
only new insertions of the block with the new attribute definitions are displayed.

Use Sync in the Block Attribute Manager to apply changes immediately to existing block 
instances. This temporarily overrides the Apply changes to existing references option. 

Tip
If constant attributes or nested attributed blocks are affected by your changes, use the REGEN 
command to update the display of those blocks in the drawing area. 

Remove
This button removes the selected attribute from the block definition. If the Apply changes to 
existing references check box is selected in the Block Attribute Settings dialog box before 
you choose the Remove button, the attribute is removed from all instances of the block in the 
current drawing. If this check box is cleared before choosing the Remove button, the attribute 
is removed only from the attribute list and the blocks that will be inserted henceforth. You can 
remove attributes from block definitions and from all existing block references in the current 
drawing. Attributes removed from existing block references do not disappear in the drawing 
area until you regenerate the drawing using the REGEN command. You cannot remove all 
attributes from the block, at least one attribute should remain. However, if you want to remove 
all the attributes, you have to redefine the block.

Note that the Remove button is not available for blocks with only one attribute. 

Extracting Attributes
  Ribbon:  Insert > Linking & Extraction > Extract Data  	  
  Command:  EATTEXT or DATAEXTRACTION  		

The Extract Data tool allows you to extract the block attribute information and property 
information such as drawing summary from single or multiple drawings. The settings 
that were used to extract data are stored in the data extraction (.dxe) file format. When 

this tool is invoked, the Data Extraction wizard is displayed (Figure 15-15). This wizard includes 
the following pages:
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Begin
The Begin page, as shown in Figure 15-19, allows you to save the settings that are meant to be 
used for extracting data to a new .dxe file or to modify an existing .dxe file. You can also use the 
saved .dxe or .blk file as the template of settings for extracting data. 

Figure 15-19  The Begin page of the Data Extraction wizard

This wizard page has two radio buttons: Create a new data extraction and Edit an existing 
data extraction. If you select the Use previous extraction as a template [.dxe or .blk] check 
box, you will be allowed to select an existing template file. To select a template file, choose the 
Browse[...] button available on the right of the template name edit box. A .blk template file is 
a text file that allows you to specify the attribute and property values that you want to extract 
and the information about the drawing that you want to retrieve. The file can be created by 
using any text editor such as Notepad or WordPad. While using a .blk template file, you will be 
prompted to save the data extraction to a .dxe file to extract the information. Select the Edit an 
existing data extraction check box to modify an existing .dxe file. Now, you will be allowed to 
select the existing data file. To select a template file, choose the Browse[...] button available on 
the right of the template name edit box.

Choose the Next button from the Begin page of the Data Extraction wizard; the Save Data 
Extraction As dialog box will be invoked. Next, specify the desired name and location in this 
dialog box to save the .dxe file and choose the Save button; the Define Data Source page will 
be displayed, as shown in Figure 15-20.

Define Data Source
The Define Data Source page is used to select an object either from a single drawing or from 
multiple drawings. The Data source area of this dialog box has two radio buttons: Drawings/
Sheet set and Select objects in the current drawing.

Drawings/Sheet set
This radio button enables you to specify the drawings and folder from which you can extract 
the data. If this radio button is selected, the Add Folder and Add Drawings buttons will be 
enabled. The name of the drawings selected will be displayed with full path in the Drawing 
files and folders area.
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Figure 15-20  The Define Data Source page of the Data Extraction wizard

Choose the Add Folder button; the Add Folder Options dialog box will be invoked, see 
Figure 15-21. All drawings within the added folder will be considered for extracting data. To add 
a folder, choose the Browse[...] button available on the right of the Folder display box. Select 
the Automatically include new drawings added in this folder to the data extraction check 
box in the Options area to automatically consider the new drawing added to this folder for 
data extraction. Select the Include subfolders check box to include the drawings within the 
subfolders of the folder selected to be added. Select the Utilize wild-card characters to select 
drawings check box to include only the files matching the specified wild-card characters for 
data extraction. By default, *.dwg is used as the wild-card character and that is why, all the files 
with extension .dwg(all the drawing files) are considered for the data extraction. For example, 
if you want AutoCAD LT to consider all the drawing files having “computer” in their name, 
enter the wild-card character *computer*.dwg. Next, specify the desired settings and choose 
the OK button. 

Figure 15-21  The Add Folder Options dialog box

Similarly, you can add a single drawing for the data extraction by choosing the Add Drawings 
button of the Define Data Source page of the Data Extraction wizard.
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Select the Include current drawing check box in the Define Data Source page to add the current 
drawing for the data extraction including the folders and drawings. 

Select objects in the current drawing
This radio button enables you to add the selected object from the current drawing for the data 
extraction. If you select this radio button, the Select objects in the current drawing button will 
be enabled. Choose this button to select the objects from the drawing.

Drawing files and folders
This area of the dialog box displays the tree view of all the drawing and folder names with their 
locations that are selected for the data extraction. All the drawing and folders are displayed under 
the Folders and Drawings heads respectively. Only the checked drawings under the folder are 
included for the data extraction. You can also remove the selected drawing or folder from the 
list of drawing to be used for data extraction. To remove the file or folder from the list of files 
and folders to be used for the data extraction, select them from the Drawing files and folders 
area and choose the Remove button.    

Settings
Choose the Settings  button from the Define Data Source  page to invoke the 
Data Extraction - Additional Settings dialog box, as shown in Figure 15-22. This dialog box 
has two areas: Extraction settings and Extract from. By default, the Extract objects from blocks 
and Extract objects from xrefs check boxes are selected in the Extraction settings area. The first 
two check boxes allow you to specify whether you want to extract the block attribute information 
from the external reference drawings or the nested blocks, or both. If you select the Include 
xrefs in block counts check box, then the xrefs will automatically be included while counting 
the blocks. The two radio buttons available in the Extract from area allow you to control the 
settings for counting the blocks. If you select the Objects in model space radio button, only the 
blocks currently inserted into the model space will be counted. If you select the All objects in 
drawing radio button, all the blocks from the current drawing will be counted. Choose the OK 
button to exit the Data Extraction - Additional Settings dialog box. Choose the Next button 
from the Define Data Source page; the Select Objects page of the Data Extraction wizard will 
be displayed.

Figure 15-22  The Data Extraction - Additional 
Settings dialog box

Select Objects
The Select Objects page, as shown in Figure 15-23, allows you to filter out the objects to be 
included for data extraction. The objects that are checked in the Objects list box will only be 
considered for data extraction. The objects that are present in the current drawing are checked by 
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default. Apart from the check box column, three more columns namely, Object, Display Name, 
and Type are displayed in the Objects list box. These columns display the information about 
the objects that are available to be selected and their type based on blocks and non-blocks.

Figure 15-23  The Select Objects page of the Data Extraction wizard

The Display options area is used to control the objects to be displayed in the Objects list box. 
You can sort out the display from the blocks and non-blocks, blocks having attributes, and objects 
used in the current drawing. After specifying the objects to be displayed, choose the Next button 
from the Select Objects page to move to the Select Properties page. 

Tip
You can reverse the display order of the entities by clicking on the respective column head in the 
Objects list box. The direction of the arrow displayed at the column head of the selected column 
represents whether the data is arranged in the ascending or the descending order. 

        

Select Properties
This page, as shown in Figure 15-24, allows you to select the properties of the objects to be 
included for data extraction. Only the properties that are checked in the Properties list box are 
considered for data extraction. Apart from the check box column, three more columns namely, 
Property, Display Name, and Category are displayed in the Properties list box. These columns 
display the information about the available properties and their category.

The Category filter area is used to control the properties further to be displayed in the Properties 
list box. To do so, select the categories of the properties to be included in the Properties list 
box. For example, if you select the Attribute check box in the Category filter area, only the 
information about the attributes defined for the drawing will be extracted and displayed in 
the Properties list box. All the properties and categories displayed here are similar to the one 
displayed in the Properties palette.

You can also edit the names below the Display Name column. Select the row for which you 
want to change the display name and double-click on the Display Name column or right-click 
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to display the shortcut menu. Next, choose the Edit Display Name option from the shortcut 
menu and enter a new name. After specifying the properties, choose the Next button from the 
Select Properties page to display the Refine Data page.

 

Figure 15-24  The Select Properties page of the Data Extraction wizard

 

Refine Data
This page, as shown in Figure 15-25, allows you to format the data extracted from a drawing. The 
properties selected from the Select Properties page of the Data Extraction wizard are displayed 
as the column head on the Refine Data page and the extracted data is displayed under these 
column heads of the table.

Figure 15-25  The Refine Data page of the Data Extraction wizard
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The Combine identical rows check box is used to merge the rows having the same data. The 
sum of the merged rows having the same data will be displayed below the Count column head. 
The Show count column check box is used to display the Count column head on the extracted 
data table. The Show name column is used to display the Name column head on the extracted 
data table. All the check boxes explained above are selected by default.

You can also add columns from an excel sheet to the data extracted from a drawing. Choose the 
Link External Data button; the Link External Data dialog box will be displayed, see Figure 15-26. 
The options in the Link External Data dialog box are discussed next.

Figure 15-26  The Link External Data dialog box

Data link Area
This area is used to specify the excel sheet to be attached with the drawing. The Choose the 
source of the external data drop-down list displays all the external data links that are attached 
to the current drawing. Select the external data link from which you want to include the columns. 
To attach a new excel file to the drawing, choose the Launch Data Link Manager button; the 
Data Link Manager dialog box will be displayed on the screen. The other options in the Data 
Link Manager dialog box have been discussed earlier in Chapter 7 (Creating Text and Tables). 
The rest of the options in the Link External Data dialog box will be available as soon as you 
specify the external data to be linked with the drawing.

Data matching Area
The options in this area are used to establish a relationship between the data extracted from the 
drawing and the attached external excel sheet. There must be at least one cell with the matching 
data in the selected column of the drawing data and the external data column respectively. This 
matching data in the external and internal data acts as a key cell to specify the proper insertion 
of the external data into the extracted data. 
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The Drawing data column drop-down list displays all the property column heads of the data 
extracted by the drawing. Select the column head from this drop-down list that is to be used for 
matching. The External data column displays the column names from the external data. Select 
the column name from where you want to insert data into the extracted data. Select the Case 
sensitive check box to check the case of the alphabets while matching the data of the selected 
columns from the extracted and external data. Select the Ignore prefix and suffix white space 
check box to ignore the blank spaces in the front and back of the entries in the columns that 
are used for matching.

Specify preferences for matching the data and choose the Check Match button to compare 
the data of the specified columns from the extracted and external data. If the data matching 
is successful, the Valid Key message box will be displayed, see Figure 15-27. Otherwise, the 
Check Key message box will be displayed, suggesting the possible reasons of conflict between 
the two datums, see Figure 15-28. Unless there is a proper matching between the two datums, 
the merging of the external data into the extracted data will not take place.

Figure 15-28  The Check Key message boxFigure 15-27  The Valid Key 
message box

Additional columns for data table Area
This area displays all columns of the external data. Select the check box on the left of each 
column entry to include that column into the data extraction. The Use top row of external data 
as column names check box will be used to specify the first row of the selected columns as the 
column head for the extracted data. Otherwise, the column heads are displayed as Column 1, 
Column 2, and so on. By default, this check box is selected.

Specify the preferences for the external data to be included in the current data extraction in 
the Link External Data dialog box and choose the OK button. The specified columns of the 
external data will be added to the extracted data and displayed in the Refine Data page of the 
Data Extraction wizard. The drawing data column used for matching and the external data 
column included in the extracted data will be represented with an external data link symbol. 
This symbol will be displayed on the side of the column head in the Refine Data page, as shown 
in Figure 15-29.

Figure 15-29  The external data link symbol

You can also change the display order of rows in the extracted data. To do so, choose the Sort 
Columns Options button from the Refine Data page; the Sort Columns dialog box will be 
displayed, see Figure 15-30. You can define the sort order for a single column or a group of 
columns at a time with this dialog box. The options in the Sort Column dialog box are discussed 
next.
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Figure 15-30  The Sort Columns dialog box

The Define sort order list box has two columns with the Column and Order column heads. 
Click on the drop-down arrow below the Column head to display all the column head entries 
for the extracted data. Select the column for which you want to change the display order of the 
rows. Choose the Ascending or Descending option from the Order drop-down list to specify 
the display order. Choose the Add button to add more rows in the Define sort order list box 
so as to specify the display order for other columns of the extracted data. The Remove button 
enables you to remove the selected sort order from the Define sort order list box. Choose the 
Move Up or Move Down button to move the selected row in the sort order, one level up or one 
level down respectively in the Define sort order list box.      

Choose the Full Preview button; the preview will be displayed in the Full Preview window. A 
partial view of the Full Preview window is shown in Figure 15-31.   

Figure 15-31  The Full Preview window

When you right-click on the table displayed on the Refine Data page, a shortcut menu will be 
displayed, see Figure 15-32. The options in the shortcut menu are discussed next.

Sort Descending/Sort Ascending
These options sort the data of the selected column in the descending/ ascending order.

Sort Columns Options
This option is used to invoke the Sort Columns dialog box, which has been discussed earlier.

Rename Column
This option is used to rename the column head of the selected column.

Hide Column
This option is used to hide the selected column from the table of the extracted data. The selected 
column is only removed from the view, it is not deleted.
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Show Hidden Columns
This option is used to display the hidden columns. This option 
becomes available only when atleast one column is hidden from 
the view. You can choose to display all the hidden columns or 
only the selected one.

Set Column Data Format
This option is used to invoke the Set Cell Format dialog box. 
You can set the data format for the selected row through this 
dialog box.   

Insert Formula Column
This option is used to insert a formula column in the extracted 
data. Choose the Insert Formula Column option to invoke the 
Insert Formula Column dialog box, see Figure 15-33. You can 
define and insert a formula column using this dialog box. The 
entries in the Formula column are governed by the mathematical 
formula defined by using one or more columns. The entry in a 
particular cell of the formula column can be calculated by using 
the formula and taking the value from the same row under the 
column that has been used to define the formula. Enter the 
column head name to be displayed on the formula column in the 
Column name edit box. The Formula area is used to define the 
formula. To select a column to define the formula, double click on the column in the Columns 
list box, or drag and drop the selected column into the Formula area. To use an operator such 
as +,-,*,or / in the formula, choose the desired operator button from the Formula area. You 
can also make entry in the Formula area through the keyboard. Choose the Validate button to 
check the validity of the formula. If the defined formula is valid, AutoCAD LT will display the 
Valid Equation message box, as shown in Figure 15-34, and if the formula defined is invalid, the 
Invalid Equation message box will be displayed, as shown in Figure 15-35. The Formula column 
is always inserted to the right of the selected column and is indicated by a formula symbol on 
the side of the column head name, see Figure 15-36.

Figure 15-35  The Invalid Equation 
message window

Figure 15-34  The Valid 
Equation message box

Figure 15-33  The Insert Formula Column dialog box

Figure 15-32  The shortcut 
menu for the Refine Data page
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Figure 15-36  The Formula and Filter symbols

Edit Formula Column
This option is used to edit the pre-defined formula. Choose this option to invoke the Edit 
Formula Column dialog box.

Remove Formula Column
This option is used to delete the formula column from the extracted data. The Edit Formula 
Column and the Remove Formula Column options are available in the shortcut menu only 
when you right-click on the formula column.

Combine Record Mode
This option is used to control the display of the numeric data into the selected columns by 
displaying them either as separate values or collapsing the identical property rows into one and 
displaying their total sum. If any formula column is added and you apply the Combine Record 
Mode option to the formula column, then in case of the Separate Values sub-option, the formula 
will be applied after combining the identical rows. But in case of Sum Values sub-option, the 
formula will be applied to the individual rows and then the identical rows will be combined 
together and the resultant value will be displayed as the sum of those individual columns. This 
option will be available only when the selected columns have numerical data and the Combined 
identical rows check box is selected.   

Show Count Column/Show Name Column
These options are used to display the Count column and the Name column, respectively. These 
options are selected by default.

Insert Totals Footer
This option is used to add a footer row under the 
selected column. This row can display the sum, maximum or 
minimum value in the selected column, and the average of 
all values above the footer row in that column. This option is 
only available for the columns that have numerical data.

Remove Totals Footer
This option is used to remove the totals footer from the 
selected row.

Filter Options
This option is used to decide the filter criterion for the 
selected column. Choose this option to invoke the Filter 
<column name> dialog box, see Figure 15-37. Only 
the entries that fulfill the specified filter criterion will be 
displayed on the table. The column on which the filter is 
applied is represented by a Filter symbol on the side of the 
column name, refer to Figure 15-36.

Figure 15-37  The Filter <column 
name> dialog box
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Reset Filter/Reset All Filters
These options are used to remove the applied filters from the selected columns or from all the 
columns of the table at a time respectively.     

Copy to Clipboard
This option is used to copy the selected table to the clipboard.

After formatting the data from the extracted files, choose the Next button to display the Choose 
Output page. 

Choose Output
The Choose Output page, as shown in Figure 15-38, allows you to specify the format of the 
output file and the location to save it. Select the Insert data extraction table into drawing check 
box to insert the extracted data into the drawing as a table. Select the Output data to external 
file (.xls .csv .mdb .txt) check box to save the extracted data to a separate file at the end of the 
wizard. Select the Browse [...] button to specify the location to save this file. Choose the Next 
button from the Choose Output page to move to the Table Style page.

Figure 15-38  The Choose Output page of the Data Extraction wizard

Table Style
The Table Style page, as shown in Figure 15-39, will be available only if the Insert data extraction 
table into drawing check box is selected in the Choose Output page. The options in the Table 
Style page are discussed next.

Table style Area
You can select the table style from the Select the table style to use for the inserted table 
drop-down list. By default, only the Standard table style is available. To create a new table style, 
choose the Table Style button on the right of the Select the table style to use for the inserted 
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table drop-down list; the Table Style dialog box will be displayed. You can use this dialog 
box to create a new table style or modify an existing table style to be used for the extracted 
attributes.

Figure 15-39  The Table Style page of the Data Extraction wizard

Formatting and structure Area
The Use table in table style for label rows radio button will be available only when the table 
style that you have specified contains a table template. Select this radio button to insert the 
extracted data into the pre-defined tables with the pre-defined header and footers. Select the 
Manually setup table radio button to enter the title, header, and data cell styles manually. Enter 
the title for the table in the Enter a title for your table text box. Select the title style defined 
in the specified table styles in the Title cell style drop-down list. Similarly, you can specify 
the header and data cell style in their respective drop-down lists. The Use property names as 
additional column headers check box is selected by default. This option enables you to include 
the column headers into the table and use the displayed name as the header row. The preview 
of the table style is displayed on the right of the Table Style page. After specifying the Table 
Style formatting and structure, choose the Next button to move to the Finish page.

Finish
The Finish page, as shown in Figure 15-40, completes the extraction of data. Choose the Finish 
button and specify the insertion point in the drawing area to insert the extracted data. Note 
that this is possible only if the Insert data extraction table into drawing check box is selected 
on the Choose Output page of the Data Extraction wizard.

The ATTEXT Command for Attribute Extraction
  Command:  ATTEXT  

The ATTEXT command allows you to use the Attribute Extraction dialog box (Figure 15-41) 
for extracting attributes. The information about the File Format, Template File, and Output 
File must be entered in the dialog box to extract the defined attribute. Also, you must select 
the blocks whose attribute values you want to extract. If you do not specify a particular block, 
all the blocks in the drawing are used.
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File Format Area
This area of the dialog box lets you select the 
file format. You can select either of the three 
radio buttons available in this area. They are 
Comma Delimited File (CDF), Space Delimited 
File (SDF), and DXF Format Extract File 
(DXX). The format selection is determined by 
the application that you plan to use to process 
data. Both CDF and SDF formats can be used 
with the database software. All of these formats 
are printable.

Comma Delimited File (CDF). When you 
select this radio button, the extracted attribute 
information is displayed in a CDF format. Here, 
each character field is enclosed in single quotes, 
and the records are separated by a delimiter 
(comma by default). A CDF file is a text file with 
the extension .txt. Of the three formats available, this is the most cumbersome.

Space Delimited File (SDF). In SDF format, the records are of fixed width as specified in the 
template file. The records are separated by spaces and the character fields are not enclosed 
in single quotes. The SDF file is a text file with the extension .txt. This file format is the most 
convenient and easy to use.

DXF Format Extract File (DXX). If you select this file format, you will notice that the Template 
File button and edit box in the Attribute Extraction dialog box are not available. This is because 
extraction in this file format does not require any template. The file created by this option 
contains only block references, attribute values, and end-of-sequence objects. This is the most 
complex of the three file formats available and is related to programming. The extension of 
these files is .dxx.

Figure 15-41  The Attribute Extraction dialog 
box

Figure 15-40  The Finish page of the Data Extraction wizard
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Select Objects
Select the blocks with attributes whose attribute information you want to extract. You can use 
any object selection method. Once you have selected the blocks that you want to use for attribute 
extraction, right-click or press ENTER. The Attribute Extraction dialog box is redisplayed and 
the number of objects you have selected is displayed adjacent to Number found.

Template File
When you choose the Template File button, the Template File dialog box is displayed, where 
you are allowed to select a template file that has been defined already. After you have selected 
a template file, choose the Open button to return to the Attribute Extraction dialog box. The 
name of the selected file is displayed in the Template File edit box. The template file is saved 
with the extension of the file as .txt. The following are the fields that you can specify in a template 
file (the comments given on the right are for explanation only; they must not be entered with 
the field description):

BL:LEVEL	 Nwww000	 (Block nesting level)
BL:NAME	 Cwww000	 (Block name)
BL:X	 Nwwwddd	 (X coordinate of block insertion point)
BL:Y	 Nwwwddd	 (Y coordinate of block insertion point)
BL:Z	 Nwwwddd	 (Z coordinate of block insertion point)
BL:NUMBER	 Nwww000	 (Block counter)
BL:HANDLE	 Cwww000	 (Block’s handle)
BL:LAYER	 Cwww000	 (Block insertion layer name)
BL:ORIENT	 Nwwwddd	 (Block rotation angle)
BL:XSCALE	 Nwwwddd	 (X scale factor of block)
BL:YSCALE	 Nwwwddd	 (Y scale factor of block)
BL:ZSCALE	 Nwwwddd	 (Z scale factor of block)
BL:XEXTRUDE 	 Nwwwddd	 (X component of block’s extrusion direction)
BL:YEXTRUDE	 Nwwwddd	 (Y component of block’s extrusion direction)
BL:ZEXTRUDE	 Nwwwddd	 (Z component of block’s extrusion direction)
Attribute tag		  (The tag name of the block attribute)

The extract file may contain several fields. For example, the first field might be the item name 
and the second field might be the price of the item. Each line in the template file specifies one 
field in the extract file. A line in a template file consists of the name of the field, the width of 
the field in characters, and its numerical precision (if applicable). For example, consider the 
case given next.

ITEM            N015002
BL:NAME      C015000

	 Where	 BL:NAME     ---Field name 
	 	 Blankspaces ----Blank spaces (must not include the tab character)
	 	 C -------------------Designates a character field
		  N -------------------Designates a numerical field
	 	 015 ----------------Width of field in characters     
	 	 002 ----------------Numerical precision
BL:NAME
or ITEM 		  Indicates the field names; can be of any length.

C	 Designates a character field; that is, the field contains characters or it starts with  
	 characters. If the file contains numbers or starts with numbers, then C will be  
	 replaced by N. For example, N015002.
015		 Designates a field that is fifteen characters long.



15-31Defining  Block  Attr ibute s
C

h
a

p
te

r
 1

5

002		 Designates the numerical precision. In this example, the numerical precision is  
		  2, or two places following the decimal. The decimal point and the two digits  
		  following the decimal are included in the field width. In the next example,  
		  (000), the numerical precision, is not applicable because the field does not have  
		  any numerical value (the field contains letters only).

After creating a template file, when you choose the Template File button, the Template File 
dialog box is displayed, where you can browse and select a template file (Figure 15-42).

Figure 15-42  The Template File dialog box to select a template file

Note
You can put any number of spaces between the field name and the character C or N (ITEM 
N015002). However, you must not use the tab characters. Any alignment in the fields must be 
done by inserting spaces after the field name.

In the template file, a field name must not appear more than once. The template file name and 
the output file name must be different.

The template file must contain at least one field with an attribute tag name because the tag 
names determine which attribute values are to be extracted and from which blocks. If several 
blocks have different block names but the same attribute tag, AutoCAD LT will extract attribute 
values from all the selected blocks. For example, if there are two blocks in the drawing with the 
attribute tag PRICE, then when you extract the attribute values, AutoCAD LT will extract the 
value from both blocks (if both blocks were selected). To extract the value of an attribute, the 
tag name must match the field name specified in the template file. AutoCAD LT automatically 
converts the tag names and the field names to uppercase letters before making a comparison.

Output File
When you choose the Output File button, the Output File dialog box is displayed. You can select 
an existing file here, if you want the extracted or output file to be saved as an existing file. You 
can enter a name in the File name edit box in the Output File dialog box (Figure 15-43) and 
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then choose the Save button, if you want to save the output file as a new file. By default, the 
output file has the same name as the drawing name. For example, a drawing named Drawing1.
dwg will have an output file by the name Drawing1.txt by default. Once a name for the output file 
is specified, it is displayed in the Output File edit box in the Attribute Extraction dialog box. 
You can also enter the file name in this edit box. As discussed earlier, AutoCAD LT appends .txt 
file extension for CDF or SDF files and .dxx file extension for DXF files.

Figure 15-43  The Output File dialog box to save an output file

Note
You can also use the -ATTEXT command to extract attributes using the Command prompt. 
Here, you are prompted to specify a file format for the extract information and you can also 
select specific blocks to extract their attribute information. You can specify a template file using 
the Select Template File dialog box and an extract file using the Create extract file dialog 
box.

Example 3 								      
In this example, you will extract the attribute values defined in Example 2. Extract the values 
of NAME, COUNT, MAKE, PROCESSOR, HD, RAM, and ITEM. These attribute values must 
be saved in a .txt format named TEST and arranged, as shown in the table given next.

	 COMP    1	  Del		  586-60		  450 MB		 64 MB		  Computer  

	 COMP    1	  CAD-CIM	 Pentium-90	 100 Min	 32 MB		  Computer

	 COMP    1	  CAD-CIM	 Unknown	 600 MB		 Standard	 Computer   

	 COMP    1	  Gateway	 486-60		  150 MB		 16 MB 		 Computer

	  COMP   1	  Zenith		  486-30		  100 MB		 32 MB		  Computer

 	 COMP    1	  IBM		  386-30		  80 MB		  8 MB		  Computer

1.	 Open the drawing that you saved in Example 2.
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2.	 Choose the Extract Data tool from the Link & Extraction panel of the Insert tab; the Data 
Extraction wizard is displayed. Select the Create a new data extraction radio button from 
the Begin page and choose the Next button.

3.	 Enter TEST in the File name edit box of the Save Data Extraction As dialog box and choose 
the Save button.

4.	 Select the Drawings/Sheet set radio button and make sure that the Include current drawing 
check box is selected on the Define Data Source page. Choose the Next button.

5.	 Clear all check boxes in the Object column except the COMP object and choose the Next 
button.

6.	 Clear all check boxes except the Attribute check box from the Category filter area of the 
Select Properties page of the Data Extraction wizard. Also, make sure that the check box on 
the left of the HD, ITEM, MAKE, PROCESSOR, and RAM properties under the Property 
column are selected. Choose the Next button.

7.	 Arrange the display order of the columns according to the table displayed above, by dragging 
and dropping the column heads to the desired position in the Refine Data page of the Data 
Extraction wizard. Make sure that the Show count column and Show name column check 
boxes are selected. Choose the Full Preview button and check the data displayed in the 
Data Extraction - Full Preview window and match it with the table displayed above. Close 
the window and choose the Next button from the Refine Data page of the Data Extraction 
wizard.

8.	 Select the Output data to external file (.xls .csv .mdb .txt) check box and choose the Browse 
[...] button. Specify the location to save the text file, select the Text/Template/Extract File 
(*.txt) option from the Files of type drop-down list, enter TEST.txt in the File name edit 
box, and choose the Save button. Choose the Next button from the Choose Output page.      

9.	 Choose the Finish button from the Finish page of the Data Extraction wizard.

Controlling Attribute Visibility
  Ribbon:   Home > Block > Retain Attribute Display drop-down > Retain Attribute Display     	
	      Display All Attributes/Hide All Attributes	   	   Command:  ATTDISP   	         

The ATTDISP command allows you to change the visibility of all attribute values. Normally, the 
attributes are visible unless they are defined invisible by using the Invisible mode. The invisible 
attributes are not displayed, but they are a part of the block definition. You can select any one 
of the options of the ATTDISP command to turn the display of the attributes completely on or 
off. If the attributes are created in the Invisible mode and you have selected the Normal option 
from the ATTDISP command, the attributes continue to be invisible. You can also select the 
options of the ATTDISP command from the Block panel in the Insert tab. The options that 
can be chosen are Retain Attribute Display/Display All Attributes/Hide All Attributes under  
Retain Attribute Display drop-down. The prompt sequence for the ATTDISP command is 
given next.

Command: ATTDISP
Enter attribute visibility setting [Normal/ON/OFF] <Current>: Specify an option and press 
ENTER.

When you choose ON, all attribute values will be displayed, including the attributes that are 
defined with the Invisible mode. You can also do it by choosing Display All tool from Attributes 
panel. 
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If you choose OFF, all attribute values will become invisible. You can also do it by choosing Hide 
All tool from the Attributes panel. Similarly, if you choose Normal, AutoCAD LT will display 
the attribute values the way they are defined, that is, the attributes that were defined invisible 
will stay invisible and the attributes that were defined visible will be visible. You can also do this 
by choosing the Retain Display tool from the Attributes panel.

In Example 2, the RAM attribute was defined with the Invisible mode. Therefore, the RAM 
values are not displayed with the block. If you want to make the RAM attribute values visible 
(Figure 15-44), choose the Display All tool from the Attributes panel.

Figure 15-44  Using -ATTEDIT to change the attribute values

Tip
After you have defined the attribute values and saved them with the block definition, it may be 
a good idea to use the OFF option of the ATTDISP command. By doing this, the drawing is 
simplified and also the regeneration time is reduced.

Editing Block Attributes
  Ribbon:  Insert > Block > Edit Attribute drop-down > Single 	 Command:  EATTEDIT	  
  Toolbar: Modify II > Edit Attribute							     

The block attributes can be edited using the EATTEDIT command.

Editing Attributes Using the Enhanced Attribute Editor
Choose the Single tool from the Edit Attribute drop-down in the Attributes panel to edit the 
block attribute values. When you invoke this tool, AutoCAD LT prompts you to select the block 
whose values you want to edit. After selecting the block, the Enhanced Attribute Editor dialog box 
is displayed (Figure 15-45). This dialog box allows you to change the Attributes, Text Options, 
and Properties of the block attribute. This dialog box can also be invoked by double-clicking 
on the block or the attribute in the current drawing. The Enhanced Attribute Editor dialog 
box displays all the attributes of the selected block and their properties. You can change the 
properties of the attribute you want. If an attribute has been defined with the Constant mode, 
it is not displayed in the dialog box because a constant attribute value cannot be edited. The 
dialog box displays the following tabs.
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Attribute Tab
The options under this tab are used to change the value of the attribute. Also, here the Mode of 
the attribute is not displayed. The other attributes of the block such as Tag, Prompt, and Value 
are displayed, as shown in Figure 15-45.

Figure 15-45  The Attribute tab of the Enhanced Attribute Editor dialog box 

Text Options Tab
Under this tab, the options related to the text of attributes can be modified. This includes Text 
Style, Justification, Height, Rotation, Backwards, Upside down, Width Factor, Oblique Angle, 
Annotative, and Boundary width, as shown in Figure 15-46.

Figure 15-46  The Text Options tab of the Enhanced Attribute Editor dialog box

Properties Tab
This tab can be used to edit the properties of attributes such as Layer, Linetype, Color, 
Lineweight, and Plot style. Choose the Properties tab of Enhanced Attribute Editor to display 
the dialog box, as shown in Figure 15-47.  
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Figure 15-47  The Properties tab of the Enhanced Attribute Editor dialog box  

Editing Attributes Using the Edit Attributes Dialog Box
The ATTEDIT command is used to edit the block attribute values through the Edit 
Attributes dialog box. Invoke this command; AutoCAD LT prompts you to select the block 
whose values are to be edited. After selecting the block, the Edit Attributes dialog box is 
displayed (Figure 15-48). 

Figure 15-48  The Edit Attributes dialog box

The dialog box is similar to the Enter Attributes dialog box and shows the prompts and the 
attribute values of the selected block. If an attribute has been defined with the Constant mode, 
it is not displayed in the dialog box because a constant attribute value cannot be edited. To 
make any changes, select the existing value and enter a new value in the corresponding edit 
box. After you have made the modifications, choose the OK button. The attribute values are 
updated in the selected block.

If a selected block has no attributes, AutoCAD LT will display the alert message That block has 
no editable attributes. Similarly, if the selected object is not a block, AutoCAD LT again displays 
the alert message That object is not a block.

Note
You cannot use the ATTEDIT command to perform the global editing of attribute values or to 
modify the position, height, or style of the attribute value. The global editing can be performed 
using the -ATTEDIT command, which is discussed in the next section.
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Example 4							          EATTEDIT
In this example, you will choose the Single tool from the Edit Attribute drop-down in the 
Attributes panel to change the attribute of the first computer (150 MB to 2.1 GB), which is 
located in Room-1. 

1.	 Open the drawing created in Example 2. The drawing has six blocks with attributes. The 
name of the block is COMP, and it has five defined attributes, one of them is invisible. Zoom 
in the drawing so that the first computer is displayed on the screen (Figure 15-49).

2.	 Choose the Single tool from Insert > Attributes > Edit Attribute drop-down; you are 
prompted to select a block. Select the computer located in Room-1.

	 AutoCAD LT will display the Enhanced Attribute Editor dialog box (refer to Figure 15-45) 
that shows the attribute prompts and the attribute values.

3.	 Edit the values, choose Apply, and then the OK button in the dialog box. When you exit 
the dialog box, the attribute values are updated.

Figure 15-49  Zoomed view of the first computer

Tip
You can also edit the attributes with the FIND command. This command can be invoked by 
entering FIND at the pointer input. When you invoke this command, the Find and Replace 
dialog box is displayed.

When you know that a set of attributes in a drawing may have to be changed in the future, you 
can make a group out of them by using the group command. Then, you can choose the Select 
objects button in the Find and Replace dialog box, enter G at the Select objects prompt, and 
enter the name of the group; all the objects in the group will get selected.

 

Global Editing of Attributes
  Ribbon:  Insert > Block > Edit Attribute drop-down > Multiple    	 Command:  -ATTEDIT   

Choose the Multiple tool from the Edit Attribute drop-down in the Block panel to edit the 
attribute values independently of the blocks that contain the attribute reference. For example, 
if there are two blocks, COMPUTER and TABLE, with the attribute value PRICE, you can 
globally edit this value (PRICE) independently of the block that references these values. You 
can also edit the attribute values one at a time. For example, you can edit the attribute value 
(PRICE) of the block TABLE without affecting the value of the other block, COMPUTER. 
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On choosing the Multiple tool from the Edit Attribute drop-down, AutoCAD LT displays the 
following prompt:

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No]<Y>: N
Performing global editing of attribute values

If you enter N at this prompt, it means that you want to do the global editing of the attributes. 
However, you can restrict the editing of attributes by block names, tag names, attribute values, 
and visibility of attributes on the screen.   

Editing Visible Attributes Only
After you select global editing, AutoCAD LT will display the following prompt:

Edit only attributes visible on screen? [Yes/No] <Y>: Y

If you enter Y at this prompt, AutoCAD LT will edit only those attributes that are visible and 
displayed on the screen. The attributes might not have been defined with the Invisible mode, 
but if they are not displayed on the screen, they are not visible for editing. For example, if you 
zoom in, some of the attributes may not be displayed on the screen. Since the attributes are not 
displayed on the screen, they are invisible and cannot be selected for editing.

Editing All Attributes
If you enter N at the previously mentioned prompt, AutoCAD LT flips from graphics to text 
screen and displays the message stating: ‘Drawing must be regenerated afterwards’.

Now, AutoCAD LT will edit all attributes even if they are not visible or displayed on the screen. 
Also, changes that you make in the attribute values are not reflected immediately. Instead, the 
attribute values are updated and the drawing is regenerated after you are done with the com-
mand.

Editing Specific Blocks
Although you have selected global editing, you can confine the editing of attributes to specific 
blocks by entering the block name at the prompt. For example,

Enter block name specification <*>: COMP

When you enter the name of the block, AutoCAD LT will edit the attributes that have the given 
block (COMP) reference. You can also use the wild-card characters to specify the block names. 
If you want to edit attributes in all blocks that have attributes defined, press ENTER.

Editing Attributes with Specific Attribute Tag Names
Like blocks, you can confine attribute editing to those attribute values that have the specified 
tag name. For example, if you want to edit the attribute values that have the tag name MAKE, 
enter the tag name at the following AutoCAD LT prompt:

Enter attribute tag specification <*>: MAKE

When you specify the tag name, AutoCAD LT will not edit attributes that have a different tag 
name, even if the values being edited are the same. You can also use the wild-card characters to 
specify the tag names. If you want to edit attributes with any tag name, press ENTER.
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Editing Attributes with a Specific Attribute Value
Like blocks and attribute tag names, you can confine attribute editing to a specified attribute 
value. For example, if you want to edit the attribute values that have the value 100 MB, enter 
the value at the following AutoCAD LT prompt:

Enter attribute value specification <*>: 100MB

When you specify the attribute value, AutoCAD LT will not edit attributes that have a different 
value, even if the tag name and block specification are the same. You can also use the wild-card 
characters to specify the attribute value. If you want to edit attributes with any value, press 
ENTER.

Sometimes the value of an attribute is null, and these values are not visible. If you want to 
select the null values for editing, make sure you have not restricted the global editing to visible 
attributes. To edit the null attributes, enter \ at the following prompt:

Enter attribute value specification <*>: \

After you enter this information, AutoCAD LT will prompt you to select the attributes. You can 
select the attributes by selecting individual attributes or by using one of the object selection 
options (Window, Crossing, or individually). 

Select Attributes: Select the attribute values parallel to the current UCS only.

After you select the attributes, AutoCAD LT will prompt you to enter the string you want to 
change and the new string. A string is a sequence of consecutive characters. It could also be a 
portion of the text. AutoCAD LT will retrieve the attribute information, edit it, and then update 
the attribute values.

Enter string to change: Enter the value to be modified.
Enter new string: Enter the new value.

The following is the complete command prompt sequence of the -ATTEDIT command. It is 
assumed that the editing is global and for visible attributes only.

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.
Edit only attributes visible on screen? [Yes/No] <Y>: N
Drawing must be regenerated afterwards.
Enter block name specification <*>: 
Enter attribute tag specification <*>: 
Enter attribute value specification <*>: 
n attributes selected.
Enter string to change: Enter the value to be modified.
Enter new string: Enter the new value.

Note
AutoCAD LT regenerates the drawing at the end of the command automatically unless the system 
variable REGENAUTO is off, which controls automatic regeneration of the drawing. 

If you select an attribute defined with the Constant mode using the -ATTEDIT command, the 
prompt displays 0 found, since attributes with Constant mode are not editable.
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Example 5 							          -ATTEDIT
In this example, you will use the drawing from Example 2 to edit the attribute values that are 
highlighted in the following table. The tag names are given at the top of the table (ITEM, MAKE, 
PROCESSOR, HD, RAM). The RAM values are invisible in the drawing.

		    	 ITEM	   	 MAKE        	 PROCESSOR	   HD 	  	 RAM

	 COMP	 Computer	 Gateway	 486-60		  150 MB		 16 MB

	 COMP	 Computer	 Zenith		  486-30		  100 MB		 32 MB

	 COMP	 Computer	 IBM		  386-30		  80 MB		  8 MB

	 COMP	 Computer	 Del		  586-60		  450 MB		 64 MB

	 COMP	 Computer	 CAD-CIM	 Pentium-90	 100 Min	 32 MB

	 COMP	 Computer	 CAD-CIM	 Unknown	 600 MB		 Standard

Make the following changes in the highlighted attribute values shown in the above table.

1.	 Change Unknown to Pentium.
2.	 Change CAD-CIM to Compaq.
3.	 Change MB to Meg for all attribute values that have the tag name RAM. (No changes should 

be made to the values that have the tag name HD.)

The following are the steps to change the attribute value from Unknown to Pentium.

1.	 Choose the Multiple tool from Insert > Block > Edit Attribute drop-down and enter N 
at the next prompt and press ENTER as given below.

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.

2.	 You need to edit only those attributes that are visible on the screen, so press ENTER at the 
following prompt:

Edit only attributes visible on screen? [Yes/No] <Y>: 

3.	 As shown in the table, the attributes belong to a single block, COMP. A drawing may have 
more blocks. To confine the attribute editing to the COMP block only, enter the name of 
the block (COMP) at the next prompt.

Enter block name specification <*>: COMP

4.	 At the next two prompts, enter the attribute tag name and the attribute value specification. 
When you enter these two values, only those attributes that have the specified tag name and 
attribute value will be edited.

Enter attribute tag specification<*>: Processor
Enter attribute value specification<*>: Unknown

	 On entering these values, AutoCAD LT will prompt you to select attributes. Use any object 
selection option to select all the blocks. AutoCAD LT will search for the attributes that satisfy 
the given criteria (attributes belong to the block COMP, the attributes have the tag name 



15-41Defining  Block  Attr ibute s
C

h
a

p
te

r
 1

5

Processor, and the attribute value is Unknown). Once AutoCAD LT locates such attributes, 
they are highlighted.

5.	 At the next two prompts, enter the string that you want to change, and then enter the new 
string.

Enter string to change: Unknown
Enter new string: Pentium

6.	 The following is the Command prompt sequence to change the make of the computer from 
CAD-CIM to Compaq:

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.
Edit only attributes visible on screen? [Yes/No] <Y>: 
Enter block name specification <*>: COMP
Enter attribute tag specification <*>: MAKE
Enter attribute value specification <*>: 
Select Attributes: Use any selection method to select the attributes.
n attributes selected.
Select Attributes: 
Enter string to change: CAD-CIM
Enter new string: Compaq

7.	 The following is the Command prompt sequence to change MB to Meg:

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.

	 At the next prompt, you must enter N because the attributes you want to edit (tag name, 
RAM) are not visible on the screen.

Edit only attributes visible on screen? [Yes/No] <Y>: N
Drawing must be regenerated afterwards.
Enter block name specification <*>: COMP

	 At the next prompt, about the tag specification, you must specify the tag name because the 
text string MB also appears in the hard drive size (tag name, HD). If you do not enter the 
tag name, AutoCAD LT will change all MB attribute values to Meg.

Enter attribute tag specification <*>: RAM
Enter attribute value specification <*>: 
n Attributes selected
Enter string to change: MB
Enter new string: Meg

8.	 Choose the Display All Attributes tool from the Block panel to display the invisible 
attributes. 

Note
You can also use the -ATTEDIT command to edit the attribute values individually. Attribute 
value, position, height, angle, style, layer, and color can be changed using this command. 
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Example 6 							         EATTEDIT
In this example, you will use the drawing of Example 5 to edit attributes individually 
(Figure 15-50). Make the following changes in the attribute values:

Figure 15-50  Using -ATTEDIT to change the attribute values individually

a. Change the attribute value 100 Min to 100 MB.

b. Change the height of all attributes with the tag name RAM to 0.075 units.

1. 	 Load the drawing that you have saved in Example 5.

2.	 Double-click on the 100Min attribute value in the drawing; the Enhanced Attribute Editor 
dialog box is displayed.

3.	 In the Value edit box, change 100 Min to 100MB. Choose Apply and then choose OK.

4.	 To change the height of attribute text, double-click on the value of RAM in the drawing; 
the Enhanced Attribute Editor dialog box is displayed.

5.	 In the dialog box, choose the Text Options tab and change the height to 0.075 in the Height 
edit box.

6.	 Choose Apply and then OK.

7. 	 Repeat Steps 5 and 6 to change the height of the other attribute values.

Tip
When you are defining attributes and have certain attributes whose values are not known at 
that time, you should enter AAAA or something similar. Later, you can replace such text with the 
values that you have obtained, using the ATTEDIT or -ATTEDIT commands. This is easier 
than adding an attribute later after the block has already been defined.

Redefining a Block With Attributes
If a block with attributes has been inserted a number of times in a drawing and you wish to  edit 
the block geometry, or add or delete attributes from them, it may take a lot of time. You can use 
the ATTREDEF command to redefine an existing block with attributes, and once redefined, all 
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the copies of the block with attributes get updated automatically. But before using this command, 
you need to explode a copy of the block containing the attributes and make the changes or you 
may use the new geometry. If you do not explode a block and try to use this command, an error 
message will be displayed: New block has no attributes. The prompt sequence is as follows:

Command: attredef
Enter name of the block you wish to redefine: Enter the name of the block to be redefined and 
press ENTER.
Select objects for new Block...
Select objects: Select the new block geometry with attributes and press ENTER.
Specify insertion base point of the new Block: Specify an insertion base point.

After you select an insertion base point, the block is redefined and all the copies of the block in 
the drawing are updated. If you do not include an existing attribute when selecting objects for 
the new block, it will not be a part of the new block definition.

Note
The ATTREDEF command removes all the formatting changes incorporated into the property 
by the ATTEDIT or EATTEDIT command.

In-place Editing of Blocks with Attributes 
  Ribbon: Insert > Reference > Edit Reference	 Command: REFEDIT	  
  Toolbar: Refedit > Edit Reference In-Place				  

The Edit Reference tool has already been discussed in Chapter 14, Working with Blocks. 
This tool can also be used for in-place editing of blocks with attributes. After invoking 
the Edit Reference tool, select a block with attributes that you want to edit. The Reference 

Edit dialog box is displayed with the name of the block in the Reference name list box. To be 
able to edit attributes, you should select the Display attribute definitions for editing check box 
in the Settings tab of the dialog box and then choose OK to exit. When you select this check 
box, it displays the attributes and makes them available for editing. At the next prompt, Select 
nested objects, you can select any part of the block with attributes that need to be edited and 
press ENTER. If you want to edit some other objects that are part of the block, you can select 
them too. All the selected objects become a part of the working set. You will notice that when 
you select the block with attributes, the tags replace the assigned attribute values and objects in 
the drawing that were not selected appear faded. 

You can now edit the block geometry or edit only the attributes. Enter the DDEDIT command 
at the Command prompt and select the attribute to be edited at the next prompt; the Edit 
Attribute Definition dialog box is displayed. Make changes in the values displayed in the Tag, 
Prompt, and Default edit boxes and choose OK to exit the dialog box. You can then select 
another attribute to edit and so on until you have made all the modifications in the attributes 
you intended and then press ENTER to exit the command. Now, choose the Save Changes tool 
in the Edit Reference panel. An AutoCAD LT message box is displayed prompting you whether 
you want to save the changes made or cancel the command and discard the changes. Choose 
OK to save the completed changes and exit the REFEDIT command.

Once the block has been redefined, the blocks that already exist in the drawing are not updated, 
unless a change is made to a default value of an attribute that has been defined with the Constant 
mode. The modifications made using the REFEDIT command can be seen in the blocks inserted 
later.
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Note
You can also use the -REFEDIT command to change block attributes. The prompts are displayed 
at the pointer and Command prompt. All options available through the REFEDIT command 
are available here also. The DDEDIT command is used to make modifications in the attribute 
tags. Then, you can either choose the Save Changes button in the Edit Reference panel of 
the Ribbon or enter the REFCLOSE command to save and exit the command.

Inserting Text Files in the Drawing
  Ribbon: Annotate > Text > Text drop-down > Multiline Text	 	 Command:   MTEXT   
  Menu Bar:  Draw > Text > Multiline Text						              

After you have extracted attribute information to a file, you may want to insert this text 
into a drawing. You can insert this text file in a drawing by using the Import Text option 
that is displayed when you right-click in the text window of the Text Editor. The Text 
Editor is displayed on using the Multiline Text tool. 

On invoking the Multiline Text tool, AutoCAD LT prompts you to enter the insertion point 
and other corner of the paragraph text box, within which the text file will be placed. After you 
specify these points, the Text Editor is displayed. To insert the text file TEST.txt (created in 
Example 3), right-click in the text window of the Text Editor to display the shortcut menu. In 
this shortcut menu, choose Import Text. AutoCAD LT displays the Select File dialog box.
 
In the Select File dialog box, you can select the text file TEST from the list box and then choose the 
Open button. The imported text is displayed in the text window of the Text Editor (Figure 15-51). 
Note that only the ASCII files are properly interpreted. Now, click on the screen, outside the 
text editor, to get the imported text in the selected area on the screen (Figure 15-52).

Figure 15-52  The imported text file on the screen

Figure 15-51  The Text Editor displaying the imported text

You can also use the Multiline Text tool to change the text style, height, direction, width, rotation, 
line spacing, and attachment.	

  Self-Evaluation Test  
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Like the Constant attribute, the Preset attribute cannot be edited.  (T/F) 
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2.	 In case of tag names, any lowercase letter is automatically converted to an uppercase letter.  
(T/F) 

3.	 You can choose the Single tool from the Edit Attribute drop-down in the Block panel to 
modify the justification, height, or style of an attribute value.  (T/F) 

4.	 If you select the Display All option in the Attribute Display drop-down list of the Block 
panel, then even the attributes defined with the Invisible mode are displayed. (T/F) 

5.	 The entry in the Value edit box of the Attribute Definition dialog box defines the __________ 
of the specified attribute.

6.	 If you have selected the Align option from the Justification drop-down list in the Text 
Options tab of the Enhanced Attribute Editor dialog box, the Height and Rotation edit 
boxes will be __________.

7.	 You can use the __________ and __________ commands or the Properties palette to edit 
text or attribute definitions.

8.	 If the default value of the ATTDIA variable is __________, it disables the dialog box.

9.	 In the __________ file, the records are not separated by a comma and the character fields 
are not enclosed in single quotes.

10.	 The __________ command is used to redefine an existing block with attributes in a 
drawing, and once redefined, all copies of the block in the drawing are updated.

  Review Questions  
Answer the following questions:

1.	 If you do not enter anything in the Prompt edit box, the entry made in the Tag edit box 
will be displayed as prompt.  (T/F) 

2.	 You can also use the Find and Replace dialog box to modify attribute values. (T/F)

3.	 When using the Edit Reference tool for in-place editing of attributes, the existing blocks in 
a drawing do not get updated. Only the subsequent insertions display the modified block. 
(T/F)

4.	 You can use ? and * in the string value. When these characters are used in string value, 
AutoCAD LT does not interpret them as wild-card characters.  (T/F)

5.	 The template file name and the output file name can be the same. (T/F)

6.	 Not selecting any of the check boxes in the Mode area of the Attribute Definition dialog 
box displays all the prompts at the Command prompt and the values will be visible on the 
screen. This is also referred to as which mode?

		  (a) Formal			   (b) Normal
		  (c) Abnormal			   (d) None of these
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7.	 Which of the following system variables when set to 0 will suppress the display of prompts 
for the new values?

		  (a) ATTDIA			   (b) ATTREQ
		  (c) ATTMODE			   (d) ATTDEF

8.	 Which of the following commands when set to OFF option will turn off the visibility of all 
atributes?

		  (a) ATTDISP			   (b) ATTEXT
		  (c) ATTEDIT			   (d) ATTDEF

9.	 Which of the following when set to OFF, causes the AutoCAD LT to regenerate line?

		  (a) AUTOSNAP		  (b) REGENAUTO
	 (c) ATTDIA			   (d) ATTMODE

10.	 which one of the following characters start with character string for leading blank space in 
the string to be changed?

	 (a) space ( )			   (b) backlash (\)
	 (c) asterisk (*)			   (d) colon (:)		

11.	 You can insert the text file in the drawing by choosing the __________ button in the In-Place 
Text Editor dialog box displayed when using the Multi Line Text tool.

12.	 The function of the Preset option is ______________.

13.	 If you select the Constant check box in the Mode area of the Attribute Definition dialog 
box, the Prompt edit box will __________.

14.	 You should select the __________ check box in the Attribute Definition dialog box 
to automatically place the subsequent attribute text just below the previously defined 
attribute.	

15.	 The attribute extract file is saved as a __________ file.

Exercise 1 					       Attribute Definition
In this exercise, you will define the following attributes for a resistor and then create a block 
using the BLOCK command. The name of the block is RESIS.

Mode	 Tag name	   Prompt	 Default value
Verify	  RNAME	 Enter name	         RX
Verify	  RVALUE	 Enter resistance	         XX
Verify, Invisible	  RPRICE	 Enter price	         00

1.	 Draw the resistor, as shown in Figure 15-53.

2.	 Enter ATTDEF at the AutoCAD LT Command prompt to invoke the Attribute Definition 
dialog box.
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3.	 Define the attributes, as shown in the preceding table, and position the attribute text as                                     
shown in Figure 15-53.  

4.	 Use the BLOCK command to create a block. The name of the block is RESIS, and the 
insertion point of the block is at the left end of the resistor. When you select the objects for 
the block, make sure you also select the attributes.

Exercise 2 						        		  ATTDIA
In this exercise, you will use the Insert tool to insert the block that was defined in Exercise 1 (RESIS). 
The following is the list of the attribute values for the resistances in the electric circuit:

RNAME	 RVALUE        RPRICE

    R1	     	  35	   	   .32

    R2	     	  27		    .25

    R3	     	  52	  	   .40

    R4	       	  8		    .21

    RX	      	 10		    .21

1.	 Draw the electric circuit diagram, as shown in Figure 15-54 (assume the dimensions).

2.	 Set the system variable ATTDIA to 1. Use the Insert tool to insert the blocks, and define 
the attribute values in the Attribute Definition dialog box.

3.	 Repeat the Insert tool to insert other blocks, and define their attribute values as given in 
the table. Save the drawing as attexr2.dwg (Figure 15-55).

Figure 15-55  Electric circuit diagram with 
resistors for Exercise 2

Figure 15-54  Electric circuit diagram without 
resistors for Exercise 2

Figure 15-53  Drawing of a resistor for Exercise 1
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Exercise 3 						       Data Extraction
In this exercise, you will extract the attribute values that were defined in Exercise 2. Extract 
the values of RNAME, RVALUE, and RPRICE. These attribute values must be saved in a Tab 
Delimited File format named RESISLST and arranged, as shown in the following table.
	 			 
		  RESIS       1	 R1		  35		  .32

		  RESIS       1	 R2		  27		  .25

		  RESIS       1	 R3		  52		  .40

		  RESIS       1	 R4		  8		  .21

		  RESIS       1	 RX		  10		  .21

1.	 Load the drawing ATTEXR2 that you saved in Exercise 2.

2.	 Use the EATTEXT command to invoke the Data Extraction wizard, and select the 
Select Objects radio button. Now, choose the Select Objects button and select the objects 
in the current drawing, whose attributes have to be extracted. Now, choose Next in the 
wizard.

3.	 On the Additional Settings page, clear both the check boxes of the Xrefs and Nested blocks 
and choose OK and then Next.

4.	 On the Use Template page, select the No Template radio button and choose Next.

5.	 On the Select Attribute page, under the Block Name heading, select the check box named 
RESIS. In the attribute list, clear all the check boxes and select the RNAME, RVALUE, and 
RPRICE check boxes. Choose Next.

6.	 The View output page shows the result of your query. On this page, you can choose the view 
in which you want the data to be displayed in the exported file. Select the Next button.

7.	 Ignore the Save template page and choose Next.

8.	 On the Export page, enter RESISLST as the name of the output file, and save it in the Tab 
Delimited File format. Choose Finish. Use Notepad to list the output file, RESISLST. The 
output file will be similar to the file shown at the beginning of Exercise 3.

Exercise 4 						        Edit Attribute
In this exercise, you will use the EATTEDIT command to change the attributes of the resistances 
that are highlighted in the following table. You will also extract the attribute values and insert 
the text file in the drawing.

1.	 Load the drawing ATTEXR2 that was created in Exercise 2. The drawing has five resistances 
with attributes. The name of the block is RESIS, and it has three defined attributes, one of 
them is invisible.

2.	 Use the EATTEDIT command to edit the values that are highlighted in the following 
table.

	 RESIS			   R1		  40		  .32
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	 RESIS			   R2		  29		  .25

	 RESIS			   R3		  52		  .45

	 RESIS			   R4		  8		  .25

	 RESIS		  	 R5		  10		  .21

3.	 Extract the attribute values and write the values to a text file.

4.	 Use the Multiline Text tool to insert the text file in the drawing.

Exercise 5 				      Attribute Data Extraction
Use the information given in Exercise 3 to extract the attribute values, and write the data to the 
output file. The data in the output file should be Comma Delimited CDF. Use the ATTEXT or 
-ATTEXT commands to extract the attribute values.

Exercise 6 				      Attribute Data Extraction
In this exercise, you will create the blocks with the required attributes. Next, draw the circuit 
diagram shown in Figure 15-56 and then extract the attributes to create the Bill of Materials.
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Exercise 7 						       Data Extraction
In this exercise, you will create the blocks with the required attributes. Next, draw the circuit 
diagram shown in Figure 15-57 and then extract the attributes to create the Bill Of Materials.

Figure 15-57  Drawing for Exercise 7

  Answers to Self-Evaluation Test  
1. F, 2. T, 3. T, 4. T, 5. default value, 6. disabled, 7. EATTEDIT, CHANGE, 8. 0, 9. Space 
Delimited, 10. ATTREDEF


